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Question Number : 1 Question Id : 25498943515 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Pressing the key will take a snapshot of everything that is displayed on your monitor screen.
Options :

1. #* scroll lock

2. % print screen



3. % print scene

4. # print scan

Question Number : 1 Question Id : 25498943515 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
B TG H SHTADT AR BhH IR TeiRid g arell gt Sl 1 v wu=ife # o feram s
Options :
1. % I dlh
2. ¢ fle &b
3. % fiic =
4. % flic W

Question Number : 2 Question Id : 25498943516 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

In Linux, a sub directory 'mydir' of the directory 'usr' will be represented as:
Options :

1. ¥ /usr/mydir

2. % usr\mydir

3. % mydir/usr

4. ¥ /mydir/usr

Question Number : 2 Question Id : 25498943516 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

fome (Linux) T SR “usr’ P T-SRGT] 'mydir' 3! frg ¥ o gwifar SITEIT?
Options :

1. ¥ /usr/mydir

2. % usr\mydir

3. # mydir/usr



4. # /mydir/usr

Question Number : 3 Question Id : 25498943519 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

By using which tab can you convert a table to plain text in an OpenOffice writer?
Options :

1. % View

2. ¥ Table

3. # Tools

4. % Format

Question Number : 3 Question Id : 25498943519 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

3 ST 3T (open office writer) H fHT 2T BT ITUNT HRP Y T & e Bl I CRe § T¢d Jobd o2
Options :

1. * g

2. ¥ 9

3. % c

4. % B

Question Number : 4 Question Id : 25498943530 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

A on a disk is the one of the many circular ring shaped areas where data is written magnetically.
Options :

1. ¥ track

2. % oval

3. % sector

4. # disk area



Question Number : 4 Question Id : 25498943530 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

fE%h IR 9gd 4! JIHR S| aTe 98 &7 ofgl WS & Jeb g S (AT aarg, deadi gl
Options :

1. ¥ CH

2. % 3fiqd

3. % YR

4. % (&b TR

Question Number : 5 Question Id : 25498943580 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

What is the resolution of normal Blu-ray high definition?
Options :

1. # 720 x 480 pixels

2. % 1920 x 1080 pixels

3. % 680 x 440 pixels

4. % 1020 x 950 pixels

Question Number : 5 Question Id : 25498943580 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

A sIX 8T8 SR &1 Roiiegm fbdr giar 82
Options :

1. % 720 x 480 fUaTa

2. v 1920 x 1080 fUTd

3. % 680 x 440 fURTQ

4. % 1020 x 950 OTa



Question Number : 6 Question Id : 25498943584 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
Solid State Drive stores data in a
Options :

1. # Mechanical platters

2. % flash memory chips

3. % Magnetic tapes

4. % Magnetic glass

Question Number : 6 Question Id : 25498943584 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

ifers We grgd ST &l ¥ R FRAT 5
Options :

1. % ApHed wed

2. ¢ TRl AR faredt

3. % Wfes oW

4. % TYfew N

Question Number : 7 Question Id : 25498943520 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Which of the following is used for processing in the second generation of computers?
Options :

1. % Vaccum tubes

2. # Integrated circuits

3. ¥ Transistors

4. % Silicon computer chips

Question Number : 7 Question Id : 25498943520 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No



Correct Marks : 1 Wrong Marks : 0
fgaia diet o dhugext § MARIT & fore g O 9 foge Sy fasar U

Options :

1. % dagH ogd

[a¥nt

2. % éUCE Afhe
3. ¥ QiR
4. % TfrpH R fau

Question Number : 8 Question Id : 25498943523 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
In Big Data, the speed with which data is generated is called
Options :

1. ¥ velocity of big data
2. # variety of big data

3. % veracity of big data
4. # vyolume of big data

Question Number : 8 Question Id : 25498943523 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

o 31 & fora ifar @ Se1 1 IuTeH BT §, 98 T T B 87
Options :

1. ¢ T ST I a7

2. % forr ser bt fafdeydn

3. % foUT SeT ol JdT

4. % {qU1 ST DI A=A

Question Number : 9 Question Id : 25498943529 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0



What is the operating range of class 1 Bluetooth devices?
Options :

1. % 100 meters

2. # 10 meters

3. % 1 meter

4. % 300 meters

Question Number : 9 Question Id : 25498943529 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

TN | Y fSarsy & SffRfeT IS 82
Options :

1. ¥ 100 Hicx

2. % 10 HIcY

3. % 1 iR

4. % 300 HIcY

Question Number : 10 Question Id : 25498943542 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
Pascal language was invented by:
Options :

1. # Pascal

2. % Neumann

3. % Holerith

4. ¥ Niklaus Wirth

Question Number : 10 Question Id : 25498943542 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
R A Tiidsl BT MASHR 5 & IR fovan Tam U

Options :



1. % UR&bd

2. % g

3. % kY

4. ¢ FRoarg fad

Question Number : 11 Question Id : 25498943570 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Accelerated Graphics Port or AGP have been developed by .
Options :

1. ¥ Intel

2. # Samsung

3. ¥ Microsoft

4. % Apple

Question Number : 11 Question Id : 25498943570 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

TRITRCS UMb UI¢ a1 AGP &R fasRid foerar mar g |
Options :

1. ¥ Intel

2. # Samsung

3. # Microsoft

4. % Apple

Question Number : 12 Question Id : 25498943581 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

When the computer is switched on, which of the following tests does the booting process perform?
Options :

1. # Integrity Test



2. % Power-On Self-Test
3. # Software Test
4. # Reliability Test

Question Number : 12 Question Id : 25498943581 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

HEER P A I TR, T UfhaT B J T Bl BT T B St 82
Options :

1. ® gdfd e

2. ¢ TR 31 Yol ¢

3. % YRR T

4. % Ramfeferd ¢

Question Number : 13 Question Id : 25498943517 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Which of the following file systems is supported by Windows 98?
Options :

1. % NTFS

2. % EXT4

3. ¥ FAT32

4. % EXTI

Question Number : 13 Question Id : 25498943517 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
ﬁgﬁﬁﬁqumwmdows 98 WW%"
Options :

1. % NTFS

2. % EXT4



3. ¥ FAT32
4. # EXTI

Question Number : 14 Question Id : 25498943582 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Which of the following is a visual input device?
Options :

1. # Keyboard

2. # Joysticks

3. ¥ Webcam

4. ® Wii Remote

Question Number : 14 Question Id : 25498943582 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

frafaRed & I oI Ue fagsid 3ge faga g2
Options :

1. % PlaS

2. % SgRee

3. ¥ A

4. % wii Rele

Question Number : 15 Question Id : 25498943585 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Which of the following options gives the truthfulness of given statements?
(1) A digitizer converts signals into numeric values stored in a computer
(i1) OCR is a device commonly present in banks as they deal with many cheques every day.

Options :
1. ¥ (i)-TRUE, (ii)-FALSE
2. # (i)-TRUE, (ii)-TRUE



3. % (i)-FALSE, (ii)-FALSE
4. % (i) FALSE, (ii)-TRUE

Question Number : 15 Question Id : 25498943585 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

frafafaa & 9 & a1 ey U 10 HY=T &1 Toar 9ardr 32

(i) Uch RISEESH O'PU{\CQ T Al I GUsId S=ATHD A (numeric values) ﬁqﬁaﬁam%l

(ii) OCR TS UHT IUHRU g S HAR R Sl & I Bl §, SNl U fead s b O Yaifdid 1 el |
Options :

1. ¢ (i)-9d, (ii)-3T

2. % (i)-9, (il)-Td

3. % (1)-3, (ii)-3Td

4. % (1)-319d, (ii)-Td

Question Number : 16 Question Id : 25498943540 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Which of the following is NOT a method of accessing the web?
Options :

1. ¥ CPU

2. % Modem

3. % DSL

4. % ISDN

Question Number : 16 Question Id : 25498943540 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

e § Q S 1 39 9% UgTH BT U RihT 81 82
Options :

1. ¥ CPU

2. % OigH



3. % DSL
4. % ISDN

Question Number : 17 Question Id : 25498943552 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

In printers, printing head does NOT touch the paper.
Options :

1. ¥ non-impact

2. # impact

3. % dot-matrix

4. # daisy-wheel

Question Number : 17 Question Id : 25498943552 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

TR Ui oS ST bl Rl g e 5
Options :

1. ﬂ”ﬁ-sﬁa% (non-impact)

2. % T (impact)

3. % Sle-UfeH (dot-matrix)

4. % ZoI-RId (daisy-wheel)

Question Number : 18 Question Id : 25498943553 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

When do you prefer to select sleep mode of your computer?

Options :

1. ® When you wish to finish your work and want break from your work.
2. % When your computer is tired.

3. % When your computer is not halting since long time.



4. ¥ When you want to come back to work after a short break.

Question Number : 18 Question Id : 25498943553 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

3T 3T SRR T T AIS & T DI Hd aigdl i

Options :

1. % TF 31T 3T HTH WH BT I8d 81 3R 307 HTH T 3B 1 I8 8l |
2. % T 3UHT SR YP S|

3. % §q 3Ych HR A dgd o H 3R {1 3|

4. ¥ 99 39 TH DI Y foRM & 91 9199 (U= H1H TR T A8d 81|

Question Number : 19 Question Id : 25498943557 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Which of the following performs the operation like modulation and demodulation?
Options :

1. ® Satellite

2. ® (Coaxial Cable

3. # Internet Service Provider

4. ¥ Modem

Question Number : 19 Question Id : 25498943557 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

frafeied o & o Aregae 3R fSHISIeRM oY &1 T 62
Options :

1. ® Jyodse

2. % gOIEia ar

3. % eI a1 ard]

4.« ASH




Question Number : 20 Question Id : 25498943558 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

In hotspot, the access point shares the signal over distance.
Options :

1. ¥ short

2. % long

3. # extremely long

4. % very long

Question Number : 20 Question Id : 25498943558 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
glewic ¥, Ty Urse Rga &1 S IR AR IR 5|

Options :

1. ¢ Bt

2. % ofdl

3. % §gd Gl el
4. % §gd ddl

Question Number : 21 Question Id : 25498943569 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

When the computer system is corrupted and CANNOT load the OS, what is the best way to recover the files stored in that computer?
Options :

1. # Double the RAM capacity

2. % Remove the hard disk and install it to other computer to take file backup

3. # Install new file system

4. ¥ Format the hard disk

Question Number : 21 Question Id : 25498943569 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is



Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

wgﬂﬁimwﬁw%ﬁ?osﬁsﬂﬁwm%?ﬁw SR | WIS/ ARIA WISal Bl YA B BT T ST a1l
H5?

Options :

1. % A DI & B G B

2. ¢ BTS {53 &l FAdIe SR BIEd 93U oH & ol 30 3 HeR WR R H

3. % 71 Blsd ReH RIIUd B

4. % TS &P Wife I

Question Number : 22 Question Id : 25498943512 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

You want to connect your computer to another computer over a network. Referring to the given scenario, identify the name of the card that you
will require.

Options :

1. ® Sound card

2. % VGA card

3. % Network interface card

4. ® Expansion card

Question Number : 22 Question Id : 25498943512 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

aéﬁ%@ﬁ?ﬂéw&mﬁdauicﬁﬁ TR HICR Y Hde BT I8d ¢ | 39 UM T IT H1S & A1 &1 UgaH &L a1 SUH! STazgdhd
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Options :

1. % IS FTS

2. % ST BT

3. ¢ Jcdd $ebhY B

4, % SRURM B




Question Number : 23 Question Id : 25498943526 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Access control mechanism in any system is designed to prevent and access to unauthorised users.
Options :

1. * use

2. % guide

3. ¢ restrict

4. % free

Question Number : 23 Question Id : 25498943526 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

foradt +ft R o uga e o (TR el Abi-eH) B 3fRipd STaNTehd! B A 3R ugd & for fese= fasar S g
Options :

1. % SUGN

2. % ATfeR® (MZS)

3. ¢ Yfdsiferd

4. % Had

Question Number : 24 Question Id : 25498943527 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Pretty good privacy (PGP) is used in security.
Options :

1. ¥ email

2. % browser

3. % FTP

4. % cookies

Question Number : 24 Question Id : 25498943527 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No



Correct Marks : 1 Wrong Marks : 0

Ry A i s vigadd (pGr) 1 SUA fhar S ]
Options :

1. v 30d

2. % 3o}

3. * FTP

4. % Dol

Question Number : 25 Question Id : 25498943528 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Which file format is used to save MS Access report snapshot?
Options :

1. # .acrs

2. * .mars
3.9 snp
4 e

.ars

Question Number : 25 Question Id : 25498943528 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

MS AccessWWﬁﬂ%ﬁﬁ%%’Qd)\H I hlgd hiHc WWWW%7

Options :

1. # .acrs
2. % .mars
3. % snp
4. ®

.ars

Question Number : 26 Question Id : 25498943539 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0



Laser jet printer is a type of:

Options :

1. *¥ impact printer

2. % non-impact printer

3. # both impact printer and non-impact printer

4. % scanner

Question Number : 26 Question Id : 25498943539 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
dRE iR S TH USRI
Options :

1. % gWae iR

2. ¢ AM-3WE flier

4. % TR

Question Number : 27 Question Id : 25498943548 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Most MP3 encoding software allow the user to select the when converting files into the MP3 format.
Options :

1. ¥ bit rate

2. % bit decoder

3. # bit format

4. % bit encoder

Question Number : 27 Question Id : 25498943548 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
TABIR MP3 TDHITST VIR UMD DI HBISA Bl MP3 BIHC H Hdc Hd G5 &1 I I DI A A B |

Options :



.« foee

2. % fge fspiex
3. % fge BiHe
4. % fde TP

Question Number : 28 Question Id : 25498943531 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Which printer uses heated pins to "burn" images onto heat-sensitive paper?
Options :

1. # Laser

2. % Inkjet

3. % Thermal

4. ®# LED

Question Number : 28 Question Id : 25498943531 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

I 91 flfer SHHAT-HaaT=ie TR IR Bl Y g & fore 74 U 1 SudivT ol g2
Options :

1. % doR

2. % bvic

3. yHd

4. % TRl

Question Number : 29 Question Id : 25498943571 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Measurement of picture size or screen resolution is defined as:
Options :

1. % Block



2. % Pixel
3. # Frame
4. # Kilobytes

Question Number : 29 Question Id : 25498943571 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

forr 3R a1 T ReiTeg=M & AU &1 fhd YR ufe i fopar wimar 82
Options :

1. ® il

2. ¢ T

3. % 1bH

4. % fobdllaTge

Question Number : 30 Question Id : 25498943572 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

While installing Windows 2000 on a dual-boot workstation with DOS or Windows Me and if the partition is larger than 2 GB, will be
used.

Options :
1. ¥ FAT 32
2. % NTFS
3. # exFAT
4. % FAT

Question Number : 30 Question Id : 25498943572 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

I (DOS) TT {8 THE (Windows Me) & Y F3IA-§¢ I T WR [ISIST 2000 RIMT F¥Te) HRd THT 3R IS Uiz 2 GB T §31
Al BT IUTNT fma ST |

Options :

1. ¢ FAT 32




2. % NTFS
3. # exFAT
4, % FAT

Question Number : 31 Question Id : 25498943513 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
Netscape Navigator is a type of
Options :

1. ¥ Browser

2. # E-mail

3. % URL

4. ® Network

Question Number : 31 Question Id : 25498943513 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
FeqPHY AfATIeR TH UHR B gl
Options :

1. ¥ dI3SR

2. % SN

3. ¥ URL

4. % Jeddh

Question Number : 32 Question Id : 25498943514 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

On a web page, if your pointer suddenly changes to a hand, what have you found?
Options :

1. # A help facility

2. % An error

3. % A picture



4. ¥ A hyperlink

Question Number : 32 Question Id : 25498943514 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

39 U R, If YT Ulgex AP Th 81U & DR T ded Soildl o, af 3! 1 e g2
Options :

1. % gou Biyferdd

2. ® PHIs T

3. % fo

4. ¥ BIRWId®

Question Number : 33 Question Id : 25498943518 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Page break is available in which tab of MS-Word 20167
Options :

1. ¥ HOME

2. % EDIT

3. ¥ FORMAT

4. ¥ INSERT

Question Number : 33 Question Id : 25498943518 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

TS S MS Word 2016 & o od B JUa g1l 32
Options :

1. ¥ HOME

2. % EDIT

3. ¥ FORMAT

4. ¥ INSERT



Question Number : 34 Question Id : 25498943522 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
is the quickest way used to create a PowerPoint 2016 presentation.
Options :
1. % Word for windows templates
2. # Auto creation wizard
3. ¥ Template

4. % Presentation wizard

Question Number : 34 Question Id : 25498943522 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

PowerPoint 2016 TR0 (SSICRM) -1 & T IUAT a1 ST aral Ja ol aRidl gl
Options :

1. % 98 BIR ICEIS émﬁa{ (Word for windows templates)

2. % 3ife) fpueH faems (Auto creation wizard)

3. ¢ ¢Hqic (Template)

4. % goiewH faems (Presentation wizard)

Question Number : 35 Question Id : 25498943536 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
MS-Word provides that allow(s) you to indent paragraphs to the location you want.

Options :

1. ¥ indent markers

2. % paragraph markers
3. # auto correct

4. % drop cap

Question Number : 35 Question Id : 25498943536 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is



Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

MS Word H gid & RO 3y frdt IRh o1 gl IR i §8¢ B b ¢
Options :

1. ¢ 33T HIHY

2. % UREI% AIhY

3. % 3ffal dHiac

4. % I HY

Question Number : 36 Question Id : 25498943537 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

When I open the drop down list of line spacing in MS-Word 2016, up to how many spacing options can I see?
Options :

1. # Five

2. ¥ Six

3. ¥ Seven

4. % Four

Question Number : 36 Question Id : 25498943537 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

MS Word 2016 & 13- WRAT &} 314 ST3 fere &1 Wi W gt fra Wiki fasrey faad 82
Options :

1. % g9

2.9

3. % 9id

4. % 9R

Question Number : 37 Question Id : 25498943543 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No



Correct Marks : 1 Wrong Marks : 0

The reviewing pane of the Review tab in MS-Word 2019 has number of options in the drop down menu.
Options :

1. %1

2.2

3.%3

4. % 4

Question Number : 37 Question Id : 25498943543 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

MS-Word 2019 & f¥og ¢q 3 Regfdt 89 % g1 S84 A H fIbea &1 TJ=m g gl
Options :

1. %1

2.9 2

3.% 3

4. % 4

Question Number : 38 Question Id : 25498943545 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

In MS-Word 2013, on which of the following groups of the Home tab are the alignment options available?
Options :

1. * Font

2. % Standard

3. # Status

4. ¥ Paragraph

Question Number : 38 Question Id : 25498943545 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

MS Word 2013 T 81 ¢§ & F=afaiiad & 9 forg qu o wars-He fadwed Aieg 8ld 82




Options :

1. % BT
2. % LUES
3. % Wy
4. ¢ IRTUTH

Question Number : 39 Question Id : 25498943554 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
The given icon stands for in the Create group under the Mailing tab.

Options :

1. # Envelopes
2. ¥ Labels

3. % Letter

4. % Greeting card

Question Number : 39 Question Id : 25498943554 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
AT ¢d & sfafd forue Ju & fau Tu s iq & fore S fomd oma 82

Options :
1. # U4y



2. ¢ qFd
3. % TR
4. % ffETHTS

Question Number : 40 Question Id : 25498943521 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Which keyboard shortcut key is used to send a mail in MS Outlook?
Options :

1. ¥ Alt+S

2. % Alt+F5

3. % Alt+P

4. % Alt+C

Question Number : 40 Question Id : 25498943521 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

MS Outlook T B WM & foTT ford Blas ACHT BI BT SUANT fsaT STl 52
Options :

1. ¥ Alt+S

2. % Alt+F5

3. % Alt+P

4. % Alt+C

Question Number : 41 Question Id : 25498943524 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
BHIM is a mobile app developed by .
Options :

1. ¥ NDI

2. % NCPT



3. ¥ NPCI
4. % UTT

Question Number : 41 Question Id : 25498943524 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

BHIM (Y17 Hiega T eR1 faw g frar man 3|
Options :

1. % T.81.3M18 (NDI)

2. % TGS (NCPT)

3. ¢ TGV 313 (NPCI)

4. % g (UTT)

Question Number : 42 Question Id : 25498943525 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

The chart shows the relationship of the parts to a whole, but it can contain more than one data series.
Options :

1. # radar

2. # line

3. # surface

4. ¥ doughnut

Question Number : 42 Question Id : 25498943525 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
T1¢ fpelt quf A 3R 39 el & o & Tay &I e DRl 6, Al SUH 3Midha! BI TbIeem A AHd gl gl g |
Options :
1. % ISR
2. % dlgd
3. % HJHIA




4. v e

Question Number : 43 Question Id : 25498943538 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

If Satheesh wants to see where has he added page breaks, he has to click Home and, in the Paragraph group, click
Options :

1. ¥ Show/Hide

2. % View

3. * Breaks

4. * Print Preview

Question Number : 43 Question Id : 25498943538 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

g T a1 18l ¢ b 3 U 9 gl UR US bl &, al 39 811 W fFadh axds IR g9 IR fadte &A1 ATeu|
Options :

1. ¥ TNEZS

2. % Y

3. % g

4. % fiic g

Question Number : 44 Question Id : 25498943541 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Sita wants to delete the conversion of punctation to emojis, which is done through the AutoCorrect feature of MS-Word 2019. Arrange the below
steps in a proper order.

1) Select AutoCorrect Options and then select Replace text as you type.

2) Go to File > Options > Proofing

3) With the autocorrect entry highlighted in the list, choose Delete.

4) In the Replace box, type the punctuation.

Options :

1. % 2,1,3,4



2.¥2.1,4,3
3.9 2,3, 1,4
4. % 1,2,3,4

Question Number : 44 Question Id : 25498943541 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

it faRTH frg & SHSIY H gHaTe FUaRYl Pl G A6 &, St MS-Word 2019 & AutoCorrect BTaR & HIZH ¥ 1 Wi 5| 1 lGT W
RO b1 I hH H AR BR |

1) AutoCorrect famey ﬂef 3R R Replace text as you type [ ddq |
2) File > Options > Proofing UR SIT¢

3) chﬁ T gIRATEC I T8 Wd: JUR (autocorrect) Ufaf & 1Y, Delete ﬂef |
4) Replace gl ﬁ, fam ﬁlﬁ' HELS |

Options :

1. % 21,34

2.9 2143

3. %2314

4. % 1,2,3,4

Question Number : 45 Question Id : 25498943544 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

MS-Word also allows to adjust the columns by adding .
Options :

1. ¥ column breaks

2. * page breaks

3. #* line breaks

4. % paragraph breaks

Question Number : 45 Question Id : 25498943544 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0



MS Word H 30 TS dah I HIaH &) TSoRe aR Idhd & |
Options :

1. ¢ HIH o

2. % UST o

3. % AR D

4. % IRIUTP SH

Question Number : 46 Question Id : 25498943555 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

To start from a ready-to-use mail merge template that can be customised according to the needs, the radio button has to be enabled under
'Select starting document' for mail merging the letters.

Options :

1. # Use the current document
2. % Start from a template

3. % Start from existing template

4. ® Start using current document

Question Number : 46 Question Id : 25498943555 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

TP YoI-¢-gu1 Hdl Aol IEie J IR B & g oI Sagardish & SUR HICHTS [T off ¥l §, MS-Word 2019 H Tcd & Hd
AfoiT oq Ridiae wifdT Slagfic s dgd ST 94 DI THId H=A1 g

Options :

1. # A XISl BT STANT B (Use the current document)

2. ¢ Th cHdle ¥ PICS) N (Start from a template)

3. % ﬁ@éﬁﬁ?@ﬂgaﬁ (Start from existing template)

4. % gaqM GXATASl BT SYTN] R[> N (Start using current document)

Question Number : 47 Question Id : 25498943573 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0



The layout is useful when you want to show all the field names as heading labels and are not concerned about the width of the pivot table
but want to reduce the number of rows in MS-Excel.

Options :

1. % Design Form
2. ¥ Tabular Form
3. % Outline Form

4. % Compact Form

Question Number : 47 Question Id : 25498943573 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

MS-Excel #  W-313¢ ad Iuunf gid1 8 5a 3y I+t wics ! o1 2fivfes dael & U # feamr amgd € iR $Heid oad &l disE o
3T g HAAS 6] gIdl § b ST Ufadd! &) IS HH W1 18 g |

Options :

1. % fEogA wIg

2. ¢ SR BIH

3. % 33carsd Wid

4. % PHiae HBIH

Question Number : 48 Question Id : 25498943574 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Which of the following sequences can be used to change the system date and time in Windows 10 operating system?
Options :

1. ¥ Start menu -> Control Panel -> Date and time

2. # Control Panel -> Start menu -> Date and time

3. % Date and time -> Control Panel -> Start menu

4. % Start menu -> Date and time -> Control Panel

Question Number : 48 Question Id : 25498943574 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0



Windows 10 3TORICT Ried & Ried 1 S¢ 3R <3A &1 daa- o fore Fa O 9 oo S &1 ITNT foedT off Favell 62
Options :

1. ¢ WIE T -> Held Ud -> 3¢ TS T8H

2. % FHeld Ud > W 7 -> S¢ TS ezd

3. % ST US TRHA > Held 4 -> WIe U,

4. % WIC T -> 3¢ TS T_H -> deld UAd

Question Number : 49 Question Id : 25498943535 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Hom many types of multiple page options are available in the Pages group of Page Setup in MS-Word 2007?
Options :

1. # 1

2. %2

3.% 3

4.9 4

Question Number : 49 Question Id : 25498943535 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

MS-Word 2007 5 Ul Te-3U & U JU & Iua« Heeud U fadhed] o1 S fbat gl 82
Options :

1. %1

2. %2

3.%3

4. 4

Question Number : 50 Question Id : 25498943546 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
When you need a different header or footer in MS-Word 2010:
Options :



1. ® click Hyphenation from the Page Setup group, insert header or footer
2. % click the Page Layout tab, insert header or footer
3. % open line numbers option, insert header or footer

4. ¥ insert section breaks, click anywhere in the section of your document, insert header or footer

Question Number : 50 Question Id : 25498943546 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

O§ 3{TUH! MS-Word 2010 H [ e (header) 4T read (footer) CAREICLEE] Eﬁ, dr:

Options :

1. # UJY Y3 dHg (Page Setup group) B EYERE] (Hyphenation) UX fda® &, 2Muaw (header) T read (footer) C B

2. % U9 A3M3C ¢d (Page Layout tab) UX fFad 3, PILSEE] (header) 9T lead (footer) C BN

3. % @R A9y (line numbers) fadey 3iiua &9, Yfivora (header) 9T ead (footer) C B

4. ¥ AR SN (section breaks) 37\‘:|_cF aﬁ, 3O W_{ & YR H Hgl Wt faad ﬁ, RILEES] (header) 4T I LRG| (footer) QT\ERF GeRy

Question Number : 51 Question Id : 25498943556 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

In MS-Word 2016, the task of choosing a document from the existing documents is done in which of the following steps of the mail merge
process?

Options :

1. #® First
2. ® Third
3. % Second
4. % Fifth

Question Number : 51 Question Id : 25498943556 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
MS-Word 2016 H, HislaT Slagdic & 3 forht Siagiic & g &1 w1 Aa Jot ufehar & fFafaied & 9 forg wror & far S g2

Options :




1. % Ugd
2. % TR
3. ¢ TW
4. % UiTd

Question Number : 52 Question Id : 25498943586 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Which of the following is a great way to save and organize specific websites so you can revisit them again and again?
Options :

1. * History

2. % Settings

3. % Bookmarks

4. % Downloads

Question Number : 52 Question Id : 25498943586 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

fFrofafed & & oH-ur, fowd faf Jeurse! & 49 B aUT HARYT HIA BT U ITH dIdT g dlids 3T 39 IR TR-8R Sff Jab?
Options :

1. # %@ (History)

2. % Iid (Settings)

3.9 W (Bookmarks)

4, % m (Downloads)

READING COMPREHENSION

Section Id : 2549895071
Section Number : 2
Section type : Online

Mandatory or Optional : Mandatory



Number of Questions : 1
Number of Questions to be attempted :

Section Marks : 5

Display Number Panel : Yes

Enable Mark as Answered Mark for Review and Clear Response : Yes
Sub-Section Number : 1
Sub-Section Id : 2549895112
Question Shuffling Allowed : Yes

Question Id : 25498943563 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension
Questions : No

Question Numbers : (53 to 57)
Read the following passage and answer the questions:

A Blind Horse

One day in a far-off village a farmer was feeding his horse named Buddy when a stranger came and stood near him. The stranger was desperately
looking for help. He approached the farmer and requested him to help him. The stranger told him that he was driving through the village in his
van when he lost control and the van fell into a ditch. The stranger asked the farmer if his horse could somehow pull the van out of the ditch. He
told the farmer that the van was not a very big one so the horse should have no problem pulling it out.

The farmer heard his story and said he would try to help him. He brought his horse, took one good look at the horse and then said that he could
not promise that he could help. The farmer was worried about his horse: what if the horse got injured while attempting to pull the van out of the
ditch. But after seeing the van the farmer realized that the stranger was right in saying that the van was small. The farmer took a rope and fixed it
so that his horse, Buddy, would be able to pull the vehicle out of the ditch.

The farmer then said, "Pull, Saggu, Pull," but the horse would not budge. The farmer then said, "Pull, Ballu, Pull," but the horse did not budge.
The farmer then said, "Pull, Mandy, Pull," and again the horse refused to move. The farmer then said, "Pull, Buddy, Pull," and the horse
immediately pulled with all his might. Soon the van was out of the ditch.

The stranger was very grateful to the farmer but asked him why he called the horse by different names.
The farmer explained, "Buddy is blind, and I have to make him think that he is not alone but has help at hand to pull the van out of the ditch".

Sub questions

Question Number : 53 Question Id : 25498943564 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0



The farmer’s horse was called
Options :

1. ® Ballu

2. ® Mandy

3. #® Saggu

4. ¥ Buddy

Question Number : 54 Question Id : 25498943565 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

The stranger asked the farmer for help because
Options :

1. # he could not locate his van.

2. % he only knew the farmer.

3. % his van had fallen into a ditch.

4. ® his van was damaged in an accident.

Question Number : 55 Question Id : 25498943566 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Why did the farmer want to check the size of the van?

Options :

1. ¥ He did not want his horse to get injured.

2. % He wanted to check the length of the rope required to pull it out.
3. # He wanted to inspect the depth of the ditch.

4. % He wanted to examine the condition of the van.

Question Number : 56 Question Id : 25498943567 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
The farmer called his horse by different names because
Options :

1. ¥ he wanted his horse to think that other horses were helping him



2. * he had forgotten the name of his horse
3. * he wanted to show off that he had many horses

4. * he knew that one horse could not pull a van by himself

Question Number : 57 Question Id : 25498943568 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Which of the following words describes the farmer’s character?
Options :

1. * Unbhelpful

2. % Nonchalant

3. % Caring

4. * Indifferent

Question Id : 25498943563 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension
Questions : No

Question Numbers : (53 to 57)

9 TR BT U 3R I SMUR W AT T Ui & IR < |
Teh 3T e

TP g2 11d § T {1 T [ S81 AT Ul &1 a1 RIaT 36T o1 I 981 U ol ST 3R 39d U WSl 81 47| 3foia agd RIgd
T Heg Pt aarel § 7| 98 ford & U T SiR 319 e B & ol 3FRIY fohan | Sroial 5 39 9drT fs a8 39 11d § Mt Ial XgT
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Sub questions

Question Number : 53 Question Id : 25498943564 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
fPaE U Ue®  dedlull
Options :
1. % dc]
2. % TS
3. % 4[]
4.« 98l

Question Number : 54 Question Id : 25498943565 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

ol A fPa A Aee » e weT s
Options :

1. % 9g 3O 91 BT Ul Tg] T HpT

2. % 98 DHad fbAM DI ST AT

3. ¥ JUD! o TH WIS & AR TS ot

4. % 3P 4 g | erfqud g1 78 off

Question Number : 55 Question Id : 25498943566 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

foFgT o BT STHR T &1 a8l Y12

Options :

1. ¥ 98 30 Ul BI Urad g1 BT =gl Ul

2. % 9g Tid HBHIa o fo1T IR B SHTaadh AaTs DI Siid BT Argdl ATl




3. % 98 WT3 PI TTGRIS B ¢/ I8l Tl
4. % gg o= & TUTY ST =mgar uT|

Question Number : 56 Question Id : 25498943567 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

BT = 30 U1 B S-S A1 A AT Aifes |

Options :

1. ¢ 98 d18dl 4T fob 3T Ul I8 I foh 310 O'g I Hag B g A
2. % G 3T UIS BT AW e T U1

3. % g gg femmn argar U1 fos S9& Uy o8 s ¥

4. % g8 ST YT f U OTeT1 Qe I U o Wid el qabel AT

Question Number : 57 Question Id : 25498943568 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
FafRad & I &I 91 Xeg fha™ & IRA &1 quiH &l 82

Options :
|. % §PR
2. % JURAE
3. ¢ T@HTA B Il (HaRT)
4, % I

QUANTITATIVE APTITUDE
Section Id : 2549895072
Section Number : 3
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 6
Number of Questions to be attempted : 6

Section Marks : 6



Display Number Panel : Yes

Enable Mark as Answered Mark for Review and Clear Response : Yes
Sub-Section Number : 1
Sub-Section Id : 2549895113
Question Shuffling Allowed : Yes

Question Number : 58 Question Id : 25498943550 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Evaluate the following. (You are not expected to calculate the exact value)

1002 +49 x99 - 1299 =?
Options :
1. ¥ 700
2. % 600
3. % 900
4. % 250

Question Number : 58 Question Id : 25498943550 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

fraffad &1 geaie &3 | (3T e [T & TUHT T8 BT §)

1002 +49 x99 - 1299 =?
Options :
1. ¥ 700
2. % 600
3. % 900
4. % 250

Question Number : 59 Question Id : 25498943576 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0



Evaluate:

3942 +64 +3 =7
Options :

1. % 29

2. % 32

3. 21

4. % 17

Question Number : 59 Question Id : 25498943576 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

fgfefad @ gd #1|

3942 64 +3="7
Options :

1. ® 29

2. % 32

3.9 21

4. % 17

Question Number : 60 Question Id : 25498943549 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

The average age of seven boys sitting in a row facing North is 26 years. If the average age of the first three boys is 19 years and the average age
of the last three boys is 32 years, what is the age of the boy who is sitting in middle of the row?

Options :

1. % 28 years
2. ¥ 29 years
3. ® 24 years
4. % 31 years

Question Number : 60 Question Id : 25498943549 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is



Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

3ecR & AR HE H0F U Gied H 35 A a8 I Aaa Jg 26 a9 §| G 97 O F5H Hr 3Ea
g 19 39 F AR el F A T Fr Hiwd Mg 32 I g, O 9fFa F 99 F IS a5F H Ay
raar gefr?

Options :

| % 28 9§

) v 29 TF
3 % 24 99
4 % 3199

Question Number : 61 Question Id : 25498943551 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
What will come in place of question mark (?) in the following number series?

4,200, 369, 513, 634, (?)
Options :
1. = 788
2. % 715
3.% 734
4. % 755

Question Number : 61 Question Id : 25498943551 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0



fAgferfad Farv IR H uy g (2) & RIF IR 31 S

4,200, 369, 513, 634, (?)
Options :
1. % 788
2. % 715
3.¥ 734
4. % 755

Question Number : 62 Question Id : 25498943577 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

The product of three consecutive even numbers is 4032. The product of the first and the third number is 252. What is five times the second
number?

Options :
1. ¥ 80
2. % 100
3. % 60
4. % 70

Question Number : 62 Question Id : 25498943577 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
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Options :

1. ¢ 80

2. % 100

3. % 60

4. % 70

Question Number : 63 Question Id : 25498943578 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No



Correct Marks : 1 Wrong Marks : 0

The circumference of a circle 1s twice the perimeter of a rectangle. The area of the circle is 5544 sq cm. What is the area of the rectangle if the
length of the rectangle is 40 cm?

Options :

1. ¥ 1120 sq cm
2. % 1020 sq cm
3. % 1140 sq cm
4.9 1040 sq cm

Question Number : 63 Question Id : 25498943578 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
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Question Number : 64 Question Id : 25498943560 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
Three words are given, which are related in some way. Select the option in which the three words are related in the same way.

Dog : Squirrel : Tail

Options :

1. # Cottage : Hut : Palace
2. # Fish : Crocodile : Water
3. % Horse : Ox : Horn

4. % Truck : Scooter : Gear

Question Number : 64 Question Id : 25498943560 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
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Options :
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Question Number : 65 Question Id : 25498943561 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
Select the term that has the same relationship with the third term as the second term has with the first term.

Dda:aDD::Rrb:?
Options :
1. * BBr
2. ¥ bRR
3. * RRR
4. * BBB

Question Number : 65 Question Id : 25498943561 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
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Options :
1. * BBr
2. ¥ bRR
3. ¥ RRR
4. % BBB

Question Number : 66 Question Id : 25498943534 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
Pen is to poet as needle is to:

Options :

1. # thread

2. # button

3. ® sewing



4. ¥ tailor

Question Number : 66 Question Id : 25498943534 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
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Options :

1. % Ym

2. % dcd

3. % R¥ar

4. Goll

Question Number : 67 Question Id : 25498943559 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
Select the alternative with the most appropriate description about these three words.

Kennedy : Indira : Palme

Options :

1. # They were Presidents.

2. # They were Prime Ministers.

3. % They were very popular among children.

4. % All of them were assassinated.

Question Number : 67 Question Id : 25498943559 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
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Question Number : 68 Question Id : 25498943562 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

In each of the following, four words have been given, out of which three are alike in some manner, while the fourth one is different. Choose out
the odd one.

Options :

1. # Aravalli hills
2. * Shivalik hills
3. % Mole hills

4. % Satpura hills

Question Number : 68 Question Id : 25498943562 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
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Options :

1. % 3RTac ugTfedi

2. # fRrarferss ygTiSAi

3. ¢ A ggItsat

4. ® gaqysI ygIisai

Question Number : 69 Question Id : 25498943575 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
There is a certain relationship between the first two words. Select the correct option which has the same relationship with the third word.

College : Dean : : Museum : ?
Options :



1. ¥ Curator
2. % Warden
3. # Custodian

4. % Supervisor

Question Number : 69 Question Id : 25498943575 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
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Options :

1. ¥ TR
2. % gred

3. % HEINSTT
4. % {UdIgulk
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Question Number : 70 Question Id : 25498943547 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Ben Johnson (Canadian) was disqualified in the year 1988 Seoul Olympic in the Athletics.
Options :

1. % 400 m

2. % 200 m

3. ¥ 100 m

4. % 800 m

Question Number : 70 Question Id : 25498943547 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
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Options :

1. % 400 m

2. % 200 m

3.¥ 100 m

4. % 800 m

Question Number : 71 Question Id : 25498943583 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Who among the following played a leading role in 'Green Revolution' in India?
Options :

1. ¥ MS Swaminathan

2. ® C Rangarajan

3. # KV Kamath

4. % Rakesh Mohan

Question Number : 71 Question Id : 25498943583 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No



Correct Marks : 1 Wrong Marks : 0
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Options :

1. ¢ TH.TY. [HATYA

2. % I TIRIGH

3. % Bl HHY

4. % [pY HIgH

Question Number : 72 Question Id : 25498943511 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

In India, economic liberalisation started with:

Options :

1. ¢ substantial changes in industrial licensing policy.

2. # the convertibility of Indian rupee.

3. # doing away with procedural formalities for foreign direct investment.

4. ® significant reduction in tax rates.

Question Number : 72 Question Id : 25498943511 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
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Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0



As per National Forest Policy 1988, the minimum forest cover to maintain ecological balance in the plains is:

Options :
1. % 25%
2.9 33%
3. % 40%
4. % 50%

Question Number : 73 Question Id : 25498943532 Question Type
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

: MCQ Option Shuffling : Yes Display Question Number : Yes Is
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Options :
1. % 25%
2.9 33%
3. % 40%
4. % 50%

Question Number : 74 Question Id : 25498943533 Question Type
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
Match List-I and List-II to select the correct answer:

List-I (Persons)

A. Chaudhry Khaliquzzaman
B. Jawaharlal Nehru

C. Abul Kalam Azad

D. Rajendra Prasad

Options :

1. % A-4,B-2,C-1,D-3
2. % A-3,B-1,C-4,D-2
3. % A-1,B-3,C-4,D-2
4. ¥ A-2,B-4,C-1,D-3

List-IT (Books)
1. India Wins Freedom
2. Pathway to Pakistan
3. India Divided
4. Discovery of India

: MCQ Option Shuffling : Yes Display Question Number : Yes Is



Question Number : 74 Question Id : 25498943533 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
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Options :

1. ¥ A-4,B-2,C-1,D-3
2. % A-3,B-1,C-4,D-2
3. % A-1,B-3,C-4,D-2
4. ¥ A-2,B-4,C-1,D-3

Question Number : 75 Question Id : 25498943579 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
is the most significant chemical contaminant in drinking-water globally.
Options :
1. * zinc
2. #* phosphate
3. ¥ arsenic
4. % detergent

Question Number : 75 Question Id : 25498943579 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
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Question Number : 76 Question Id : 25498943588 Question Type : TYPING TEST Display Question Number : Yes

Summer camps are supervised camps conducted to entertain as well as equip students with various life skills such as teamwork,
socializing, decision making, independent and responsible living and more. It aids the overall development of a child and children have
fun during this process as they get to explore new arenas.
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Question Number : 77 Question Id : 25498943587 Question Type : TYPING TEST Display Question Number : Yes

Soil erosion is the displacement of the upper layer of soil. It is a form of soil degradation. This natural process is caused by the dynamic
activity of erosive agents. Non living agents such as water or ice and air and living agents like animals and humans. In accordance with
these agents erosion is sometimes divided into various forms of erosion such as water erosion or glacial erosion and zoogenic erosion or
anthropogenic erosion. Soil erosion may be a slow process that continues relatively unnoticed. Sometimes it may occur at an alarming
rate causing a serious loss of topsoil. The loss of soil from farmland may be reflected in reduced crop production and potential lower
surface water quality or damaged drainage networks. Soil erosion could also cause sinkholes. Human activities have increased by ten to
fifty times the rate at which erosion is occurring globally. Excessive erosion causes both onsite and offsite problems. Onsite impacts
include decreases in agricultural productivity and ecological collapse both due to the loss of nutrient rich upper soil layers. In some
cases, the eventual end result is desertification. Offsite effects include sedimentation of waterways and eutrophication of water bodies as
well as sediment related damage to roads and houses. Water and wind erosion are the two primary causes of land degradation and
combined they are responsible for about 84 percentage of the global extent of degraded land making excessive erosion one of the most
significant environmental problems worldwide. Intensive agriculture and deforestation as well as urban sprawl are amongst the most
significant human activities in regard to their effect on stimulating erosion. However, there are many prevention and remediation
practices that can curtail or limit erosion of vulnerable soils. Rainfall and the surface runoff which may result from rainfall produces
four main types of soil erosion splash erosion sheet erosion rill erosion and gully erosion. Splash erosion is generally seen as the first and
least severe stage in the soil erosion process which is followed by sheet erosion then rill erosion and finally gully erosion. In splash erosion
the impact of a falling raindrop creates a small crater in the soil ejecting soil particles. Surface runoff occurs if the soil is saturated or if
the rainfall rate is greater than the rate at which water can infiltrate into the soil. The runoff will transport loosened soil particles down
the slope if it has sufficient flow energy. Sheet erosion is the transport of loosened soil particles by overland flow. Rill erosion refers to the
development of small ephemeral concentrated flow paths which function as both sediment source and sediment delivery systems for
erosion on hill slopes. Flow depths in rills are typically of the order of a few centimetres or less and along the channel slopes might be
quite steep. This means that rills exhibit hydraulic physics very different from water flowing through the deeper wider channels of
streams and rivers. Gully erosion occurs when runoff water accumulates and rapidly flows in narrow channels during or immediately
after heavy rains or melting snow removing soil to a considerable depth. Valley or stream erosion occurs with continued water flow along
with a linear feature. The erosion is both downward deepening the valley and head ward extending the valley into the hillside creating
head cuts and steep banks.
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